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Conventions Used in this Guide

Please take a moment to review how instructions and other useful information are presented in
this documentation.

l Procedures are presented as numbered lists. A single bullet indicates that the procedure
has only one step.

l Bold type is used for the following:
o Keyboard entries that should be typed in their entirety exactly as shown. For example,
“copy file1” means you must type the word copy, then type a space, and then type
file1.

o On-screen prompts and messages, names of options and text boxes, and menu
commands. Menu commands are often separated by greater than signs (>). For
example, “click HFSS > Excitations > Assign >Wave Port.”

o Labeled keys on the computer keyboard. For example, “Press Enter” means to press
the key labeled Enter.

l Italic type is used for the following:
o Emphasis.
o The titles of publications.
o Keyboard entries when a name or a variable must be typed in place of the words in
italics. For example, “copy filename” means you must type the word copy, then type a
space, and then type the name of the file.

l The plus sign (+) is used between keyboard keys to indicate that you should press the
keys at the same time. For example, “Press Shift+F1” means to press the Shift key and,
while holding it down, press the F1 key also. You should always depress the modifier key
or keys first (for example, Shift, Ctrl, Alt, or Ctrl+Shift), continue to hold it/them down, and
then press the last key in the instruction.

Accessing Commands: Ribbons, menu bars, and shortcut menus are three methods that can
be used to see what commands are available in the application.

l The Ribbon occupies the rectangular area at the top of the application window and
contains multiple tabs. Each tab has relevant commands that are organized, grouped, and
labeled. An example of a typical user interaction is as follows:

"Click Simulation > HPC Options"
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This instruction means that you should click the HPC Options command on the
Simulation ribbon tab. An image of the command icon, or a partial view of the ribbon, is
often included with the instruction.

l Themenu bar (located above the ribbon) is a group of the main commands of an
application arranged by category such File, Edit, View, Project, etc. An example of a
typical user interaction is as follows:

"On the Filemenu, click theOpen Examples command" means you can click the File
menu and then clickOpen Examples to launch the dialog box.

l Another alternative is to use the shortcut menu that appears when you click the right-
mouse button. An example of a typical user interaction is as follows:

“Right-click and select Assign Excitation >Wave Port” means when you click the right-
mouse button with an object face selected, you can execute the excitation commands
from the shortcut menu (and the corresponding sub-menus).

Getting Help: Ansys Technical Support

For information about Ansys Technical Support, go to the Ansys corporate Support website,
https://www.ansys.com/Support. You can also contact your Ansys account manager in order to
obtain this information.

All Ansys software files are ASCII text and can be sent conveniently by e-mail. When reporting
difficulties, it is extremely helpful to include very specific information about what steps were
taken or what stages the simulation reached, including software files as applicable. This allows
more rapid and effective debugging.

Help Menu

To access help from the Help menu, click Help and select from the menu:

l [product name] Help – opens the contents of the help. This help includes the help for the
product and itsGetting Started Guides.

l [product name] Scripting Help – opens the contents of the Scripting Guide.
l [product name] Getting Started Guides – opens a topic that contains links to Getting
Started Guides in the help system.

Context-Sensitive Help

To access help from the user interface, press F1. The help specific to the active product (design
type) opens.

You can press F1 while the cursor is pointing at a menu command or while a particular dialog
box or dialog box tab is open. In this case, the help page associated with the command or open
dialog box is displayed automatically.
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1 - Getting Started

Installation Prerequisites
Before installing Ansys Electromagnetics Suite software, you will need:

l Ansys Electromagnetics physical product (USB or DVDs), or digital download.
o Includes software, example projects, and documentation.
o For download information, see: Additional Resources (Page 1-3).

l A license file (see: License File below).
l Ansys License Manager (see: Ansys License Manager below).
l TCP/IP installed, for counted evaluation and purchased licenses (see: TCP/IP below).
l A computer that meets the minimum or recommended system requirements for the
Electromagnetics products you plan to run.
o For detailed requirements, visit https://www.ansys.com/it-solutions/platform-support.

License File
Most Ansys Electromagnetics products require a license, which is sent as an e-mail attachment.
After you receive a license file, save it to a temporary location.

The license file requires a license hostid, which is a hardware device used to validate the license.
For a list of supported hostids and a general explanation of hostids, see: Appendix B.

If you do not have a license file for the Ansys Electromagnetics software you are about to install,
please contact your Ansys sales representative.

Ansys License Manager
Once you have purchased the software, you must designate a machine on your network to act
as a license server.

The Ansys License Manager must be installed in one of the following locations:

l On the computer where the software will be installed.
l On another machine accessible over the network.

Note:
You can install Ansys License Manager before or after installing Ansys
Electromagnetics software.

Ansys Electromagnetics Suite 2024 R2Windows Installation Guide
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Additional instructions are included as part of the Ansys License Manager download.

TCP/IP
Transmission Control Protocol/Internet Protocol (TCP/IP) is required to use any Ansys
Electromagnetics Suite software—even for a single computer in stand-alone mode.

l TCP/IP must be installed on the machine that is running Ansys License Manager (the
server) and on each machine that obtains licenses from that server.

l By default, TCP/IP is already installed on computers running Windows.
l TCP/IP is usually bound to a network card. If a network card is already installed and set up
for TCP/IP, no additional action is needed.

l If a network card is not installed, you can satisfy the TCP/IP requirement by installing the
Microsoft Loopback Adapter (MLA). The MLA is a software module that emulates a
network card. For more details, see the appropriate help topics in Microsoft Windows.

OpenGL
All Ansys Electromagnetics software (excluding Ansys License Manager) requires that the
OpenGL libraries be accessible from the machine running Ansys Electromagnetics software.
Most graphics card drivers automatically come with OpenGL software for Windows.

Processor Selection (for Hybrid Graphics Hardware)

In the case of laptops that have both Intel integrated graphics and an nVidia graphics
accelerator, you should ensure that the following two programs both use the "High-
performance NVIDIA processor" and not the "Integrated processor":

l Ansys Electronics Desktop (ansysedt.exe)
l Ansys SIwave (siwave.exe)

Go to the NVIDIA Control Panel > 3D Settings >Manage 3D Settings > Program Settings to
verify the settings and change them as needed.
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Note:

For Microsoft Windows 11 and newer builds of Windows 10, the NVIDIA Control Panel
might indicate the following:

Click the provided link and ensure that the two Ansys executables specified above are
added to the list underGraphics performance preference and that the High
performance option is specified. You can browse the \AnsysEM\vxxx\Win64 folder,
typically under C:\Program Files, to add the two Ansys executables to the list.

Graphics Card Recommendations

For details about graphics card recommendations and tested cards, refer to the following PDF
documents listed on the Ansys Platform Support website:

l Ansys 2024 R2 - Graphics Cards Tested
l Ansys 2024 R2 - GPU Accelerator Capabilities

Firewall Exceptions
Firewall exceptions are needed for the COM engines and Ansys Electromagnetics products if
solving remotely (something that does not necessarily require RSM). Exceptions are also
required for RSM as well if it is installed. This comes up most frequently with the Windows
firewall.

Additional Resources
Ansys Website: https://www.ansys.com
Downloads: Software downloads (including Ansys License Manager) and

installation-related documentation are available at the Ansys
customer portal, https://support.ansys.com

Online Technical Support: Available through the Ansys customer portal:
https://support.ansys.com
Under Training & Support, select from tutorials and training
materials or click Support Contacts for contact information.

Product Documentation: The online help is accessible from any Electronics product's
Helpmenu. Information about the release can be found in the
What's New documents.
PDF versions of the documentation can be found in the online
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help, or downloaded via the Downloads link on the customer
portal: https://support.ansys.com
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2 - Installing Ansys Electromagnetics Suite
Software

Installing Ansys Electromagnetics Suite on aWindows operating system generally involves the
following steps:

1. Ensuring the machine meets installation prerequisites.

See: Installation Prerequisites (Page 1-1).

2. Installing the software.
3. Setting up a license server, if prompted to do so.

Installing the Software
To install Ansys Electromagnetics software:

1. Log in as an administrator, or using an account with administrator privileges.
2. Launch the Ansys Electromagnetics Installation Shell:

l If you have a physical disc, it will launch automatically. If it does not, locate the drive and
launch autorun.exe.

l If you downloaded a digital copy, unzip the download and launch autorun.exe.
3. Click Install Electromagnetics Suite.

The Installation Wizard appears.

4. Click Next.

The License Agreement screen appears.

5. Read the license agreement carefully. Click Yes if you accept the terms of the agreement.
6. Click Next.

The Choose Destination Location screen appears.

7. Under Destination Folder, do one of the following to accept the default path or specify a
new one:
l Accept the default installation directory listed under Destination Folder.
l To select a different directory, click Browse. The Choose Folder window appears.
Select a directory, and clickOK.

If you have other Ansys Electromagnetics software, Ansys recommends that you install
new software in the same directory.

Ansys Electromagnetics Suite 2024 R2Windows Installation Guide
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l To create a new directory, click Browse. The Choose Folder window appears. Enter
the new name in the Path field, and clickOK.

8. Click Next.

Depending on the software and version being installed, you may see one or both of the
following screens before the Select Program Folder screen: the Choose Default Temp
Directory Location screen and/or the Choose Library Option screen.

9. If the Default Temporary Directory Location screen appears, select a default location
for all simulations (including local) to use as a temporary work space.
l If desired, change the temporary folder assignment. You can edit the field directly or
use the Browse button to display file browser to let you navigate the folders on your
machine and network.

l If desired, check the option to add read/write permissions for Everyone. If the
installation will be used for remote simulation by multiple users, all users must have
permissions on the temporary folder.

10. If the Choose Library Option screen appears, do one of the following to specify the
location of Ansys Electromagnetics libraries:

Note:

Ansys Electromagnetics libraries are large databases of electronic components,
developed by Ansys and various manufacturers.

l Click This local installation to copy and install the default Ansys Electromagnetics
component libraries, and then click Next.

l Click The following common location to use libraries that are already installed
(locally or on the network). Click Browse, select the appropriate path, and clickOK.
Click Next.

11. Click Next.

The License Information screen appears.

Installing Ansys Electromagnetics Suite Software 2-2
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For additional information about the three license options, click Help me decide which of
the following options to choose. This displays a browser page with additional
explanations.

Note:

You can review the current license configuration by clicking View current
license configuration.

12. Select one of the following three license options:
l I have a new license file – Select this option if you recently received a license file from
Ansys.
a. Click Next.
b. Browse and select a license file.
c. ClickOpen.
d. Click Next.
e. If prompted, enter the name of the license server. Select or clear the Specify

TCP/IP Port option. Specifying a TCP/IP Port means that the software only looks to
that port for licenses. The default port for Ansys License Manager is 1055.

f. Click Next.
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l I want to specify a license server – Select this option if you are using a counted
license and already know the machine on which the Ansys License Manager is/will be
installed.
a. Click Next.
b. Select whether you want to use a Single server or Redundant servers, and enter

server names.

A Redundant server setup requires three license servers, each serving an identical
license file. The order in which the servers are entered must match the license files
on each server.

c. Select or clear the Specify TCP/IP Port option. Specifying a TCP/IP Port means
that the software only looks to that port for licenses. For Redundant servers, you
must enter a port. The default port for Ansys License Manager is 1055.

d. Click Next.
l I want to keep the current license configuration – Select this option if you already
have a license file for a previous version of Ansys software and want to keep the same
configuration.
a. Click Next.

Note:

If you want to change the license server after installation, modify the ansyslmd.ini
file in AnsysEM/Shared Files/Licensing.

See: Updating Software and Licenses (Page 4-1).

13. On the Select Program Folder screen, do one of the following to specify a name for the
program folder:
l Accept the default name displayed in the Program Folder field.
l Select an item from the Existing Folders list.
l Type a new name for the folder in the Program Folder field.

Note:

The program folder, which appears on the Windows Startmenu, is a group of
related software that includes executable files and other components. The
default programs folder is Ansys EM Suite 20yy Rr, where yy is the last two
digits of the version year, and r is the minor release number.

14. Click Next.

The Review settings before copying files screen appears.
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15. Review the information displayed under Current Settings, and then do one of the
following:
l If the settings are correct, click Next to start copying files.
l If the settings are incorrect, click Back as many times as necessary, and change your
selections. Verify each screen before clicking Next to go to the next screen. When all
information is correct, return to the Review settings before copying files screen, and
click Next.

The Setup Status screen appears, displaying a progress bar, and installation begins.
You can click Cancel at any time to exit the installation.

Note:

If you receive a message about read-only files, you typically want to overwrite
them with the newer versions.

16. Once the files have all been copied, one of the following messages may appear:
l If you identified as the license server the same machine where you installed the Ansys
Electromagnetics software, then a message appears that informs you that you must
install the Ansys License Manager on this machine. ClickOK.

l If you identified as the license server a machine other than where you installed the
Ansys Electromagnetics software, then a message appears that identifies that machine
as the license server and informs you that you must install the Ansys License Manager
on that machine. ClickOK.

17. When the installation is complete, the InstallShield Wizard Complete window appears.

You will see one of two check box options:

l If RSM is not installed, you will see a check box to launch the RSM installation and,
once the installation is complete, register this Ansys Electromagnetics product with
RSM. If you select this option and click Finish, the product installation ends and the
RSM installation is automatically started.

l If RSM is installed, you will see a check box to register this Ansys Electromagnetics
product with RSM.

For details, see: Installing RSM (Page 3-4).

18. Click Finish.

The initial setup Installation Shell reappears.

19. Optionally, install any of the following additional software:
l Distributed Simulation Technologies, which includes MPI and RSM.
l Layout Integrations for ECAD.

20. Click Exit to terminate the Ansys Electromagnetics Installation Shell

Installing Ansys Electromagnetics Suite Software 2-5
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Integrating Ansys EM Suite with Ansys
(Workbench)
You can integrate the Ansys Electromagnetics Suite with the Ansys software (Workbench) if
both products have been installed on the same system and are the same version. The
instructions are as follows:

1. From the Start menu, select Ansys EM Suite 2024 R2 >Modify Integration with
Ansys 2024 R2.

2. In the Integration with Ansys 2024 R2 dialog box, ensure that the Yes radio button is
selected.

Installing Ansys Electromagnetics Suite Software 2-6
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3. ClickOK to complete the integration process.
4. Click Finish to close the information dialog box.

Note:

You can confirm that Ansys is aware of the Ansys Electromagnetics integrated
applications via Ansys Workbench. FromWorkbench, theOptions dialog box
(Tools >Options > Electromagnetics) shows the path to the Electronics
Desktop Install Path.
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3 - High Performance Computing
Ansys Electromagnetics products have a variety of ways to use multiple threads, multiple cores,
or multiple hosts to improve productivity. These additional computational resources may be used
to solve larger problems, to solve a given problem faster, or to improve the quality of a solution in
the same amount of time. This section describes the configuration and requirements for using
additional resources.

To make effective use of the resources allocated to the analysis, the job settings must match the
job requirements. In addition, the cluster configuration and the resources must be allocated to
the job in a way that the products are able to make effective use of the resources.

Note:

For additional information about high performance computing not in this guide, see the
Ansys Electromagnetics HPC Administrator's Guide.

Distributing Analysis to Multiple Hosts
If an analysis is distributed to multiple hosts, then the Ansys Electromagnetics Suite must
generally be installed at the same path on all hosts used for the analysis. This may be a shared
network installation that is accessible using the same path on all analysis hosts (such as
\\servername\sharename\AnsysEM\v242\Win64).

Important:

If this approach is used, then theremust not be any local installations of Ansys
Electromagnetics Suite on any of the hosts with the same major and minor version
numbers. Installing a service pack does not affect the major and minor version
numbers.

Alternatively, a separate, local installation on each host may also be used. In this case, the path
name of the installation directory (such as C:\Program Files\AnsysEM\v242) must be the same
on all hosts, and all installations must include the same service pack or packs.

A distributed analysis that does not use MPI distribution does not need to meet the above
requirement. Because MPI is used for all distribution types except for variations, MPI will not be
used only for the following cases:

l If the design type does not support the Auto option and does not allow distribution types
other than distribution of variations, then MPI will not be used for distribution. This
currently includes the Circuit Design, Circuit Netlist, EMIT, RMxprt, Maxwell Circuit, Twin

Ansys Electromagnetics Suite 2024 R2Windows Installation Guide
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Builder, and Mechanical design types.

l If the Auto option is not selected, and no distribution type other than Variations is enabled,
then MPI will not be used.

For these cases, Ansys Electromagnetics Suite may be installed at different locations on
different hosts. These locations must be registered with the RSM Service running on each host.

Distributing Analysis Across Platforms
In general, all analysis hosts should be on the same platform. That is, either all analysis hosts
should be Windows hosts or all analysis hosts should be Linux hosts. One additional
configuration is supported, with limitations: Ansys Electronics Desktop may run on aWindows
host, with solvers running onWindows or Linux hosts. This configuration is supported except for
cases in which 1) auto mode is enabled and 2) variations are distributed. If auto mode is
disabled or if all variations are analyzed sequentially, then this mode is enabled.

For this type of analysis, the machine list specified in the command line (for batch jobs) or the
machines specified in the UI (for interactive jobs) should only include the Linux solver machines.
This configuration is not supported in a scheduler environment. RSMmust be installed and
running on all of the Linux hosts, and the software must be registered with the RSM Service on
each of the Linux hosts. If the analysis uses MPI distribution, then the installation path must be
the same on all of the Linux hosts; this is the same requirement as for other configurations.

Options for Distributed Analysis
There are several options for configuring Ansys Electromagnetics products to take advantage of
additional computational resources. The simplest approach is to use the Remote Simulation
Manager (RSM) for Ansys Electromagnetics products. RSMmay be installed, configured, and
started on one or more hosts. It runs as a Windows Service. An analysis may be distributed to
any of the hosts where the Remote Simulation Manager is running. RSM is bundled with Ansys
Electromagnetics products.

There are a number of job schedulers available from third parties, such as IBM Spectrum LSF. A
job scheduler may also be called a distributed resource management system, a cluster
manager, a batch system or a distributed resource manager. These systems provide queuing of
jobs, load balancing, assigning resources to jobs, and many other management and monitoring
features. Ansys Electromagnetics products integrate with several of the most widely used job
schedulers. The user is able to submit jobs to the scheduler. When the job runs, the product
uses the resources allocated to the job to accomplish the analysis.

Users may be able to use job schedulers which are not included in the list of supported job
schedulers via “custom scheduler integration.” The end user, working with Ansys
Electromagnetics products support engineers, provides an IronPython script or code library to
act as an interface between the scheduler and the Ansys Electromagnetics products.
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The RSM for Ansys Electromagnetics products may be used for running an analysis on a remote
host or for running an analysis distributed to multiple hosts. However, the user is required to
manage the jobs and resources used by these jobs; no ability to queue jobs until needed
resources are available is provided. In general, a job scheduler is more appropriate if there are a
number of hosts shared between a number of users, because a scheduler is better able to
manage the jobs and the resources. It can queue a job and delay the start the job until
appropriate resources become available. Custom scheduler integration is needed to allow jobs
to be run on a cluster that is not managed by one of the supported job schedulers.

Remote Simulation Manager (RSM)
The Remote Simulation Manager (RSM) for Ansys Electromagnetics products may be used for
running an analysis on a remote host or for running an analysis distributed to multiple hosts.
When using RSM, users are required to manage the jobs and resources used by these jobs. No
load balancing or queueing of jobs is provided. The Remote Simulation Manager is not used if
the analysis is run as a job on one of the supported job schedulers, such as LSF or Windows
HPC. See: Supported Job Schedulers (Page 3-15). RSM is also not used if the analysis is run as
a job using custom scheduler integration with a scheduler that is not supported by default. See:
Custom Scheduler Integration (Page 3-15).

When Is RSM Needed?
RSM is needed only to run an analysis on a remote host or an analysis distributed to multiple
hosts. RSM is also required if some of the solvers are running on a hosts that run under a
different OS than the OS host that is running Ansys Electronics Desktop. If RSM is required, then
the RSM daemon or service must be configured and running on all remote hosts for the analysis.

Please note that RSM is not needed:

l To run an analysis only on the local host.
l To run an analysis using integration with a supported job scheduler or using custom
scheduler integration.

You should not install RSM on hosts that are managed by a scheduler.

If you use RSM with MPI tight integraton you must set the environmental variable ANSYS_EM_
EXEC_DIR,

Set this variable to the same value with ANSYS_EM_INSTALL_DIR (not the RSM service path).
To ensure the RSM service can accurately locate the essential script files required for MPI
integration, it is necessary to set this variable within the RSM service environment.

Enabling and Disabling Remote Access
If the Remote Simulation Manager is running on a host, by default, jobs started on remote hosts
may distribute jobs to the local host. A user may disable or enable this access using theOptions
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dialog box (Tools >Options >General Options > Remote Analysis).

The Disable access by remote machines check box, in the RSM Service Options group box
controls access. If this check box is deselected, as is the default setting, remote hosts can
distribute jobs to the local host. If this check box is selected, remote hosts cannot distribute jobs
to the local host.

Installing RSM
To install Ansys Electromagnetics RSM software:

1. Launch the Remote Simulation Manager installer:
l From the Ansys Electromagnetics installer, select Install Distributed
Simulation Technologies.

l Click Install Electromagnetics RSM.

The installer appears.
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2. Click Next.

A licensing agreement appears.
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3. Read and agree to the license agreement. Click Yes to continue.

The Choose Destination Location screen appears.
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If you have other Ansys software installed, Ansys recommends using the same installation
directory.

4. Select a destination folder. Click Next to continue.

The Service Configuration screen appears.
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5. Select the System User, or specify a Specific User with administrative privileges. The
selected user will run remote and distributed analyses when no user is specified in the
product interface. Click Next.

A review screen appears.
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6. Review the settings. If they are correct, click Next.

A progress bar displays installation progress.
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When installation has finished, a message appears.
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7. Click Finish. At the end of the installation, RSM is automatically started as a service on
this machine.

Troubleshooting Installation
If you receive a message about read-only files, elect to overwrite them.

If you use RSM, it must be installed on all remote machines. In addition, the product engines
must be registered on RSM. See below.

Registering Ansys Electromagnetics Product Engines for
use with RSM
You must make each installation of RSM aware of each Ansys Electromagnetics product, so that
remote simulation requests are properly routed to the product. For network installations, you
need only to register each Ansys Electromagnetics product once, regardless of the number of
machines. Otherwise, you need to register each Ansys Electromagnetics product on each
machine running RSM.

To register an Ansys Electromagnetics product with RSM, do one of the following:
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l FromWindows, select Start > Ansys EM Suite 2024 R2 > Register with RSM.
l Run RegisterEngineswithRSM.exe, located in the installation directory. The command
should be run from the installation path to be registered with RSM.

To un register an Ansys Electromagnetics product with RSM, do one of the following:

l FromWindows, select Start > Ansys EM Suite 2024 R2 > Unregister with RSM.
l Run UnregisterEngineswithRSM.exe, located in the installation directory.

Changing the RSM Listening Port
For Remote Analysis or Distributed Analsysis, processes may need to be started on multiple
hosts. If Ansys Electronics Desktop needs to start a process on a remote host, the RSM service
is used to start these remote processes. By default, the RSM service listens for socket
connections from the Ansys Electronics Desktop on port 32958.

This section describes how to change the port number used by the RSM service.

To change the port number, both the RSM service and Ansys Electronics Desktop must be
configured to use the new port number. The same port number must be used for Ansys
Electronics Desktop and for the RSM service process running on each host used for the
analysis.

RSM Service Configuration

The RSM service port number is configured in the ansoftrsmservice.cfg configuration file. This
configuration file is located in the platform specific subdirectory of the RSM installation directory.

In Windows, the default location of this directory is C:\Program Files\AnsysEM\RSM\Win64.

To modify the RSM service configuration:

1. Stop the service.
2. Modify the ansoftrsmservice.cfg configuration file.
3. Restart the service.

The beginning of the configuration file should appear as follows:

$begin 'AnsoftCOMDaemon'

$begin 'Default:CommDetails'

$begin 'CommDetails'

'ListenPort'='32958'

$end 'CommDetails'

$end 'Default:CommDetails'

If there are additional lines between the following two lines, then they should not be modified:

$begin 'AnsoftCOMDaemon'
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$begin 'Default:CommDetails'

To change the port number, modify the ListenPort setting within the single quotes from 32958 to
the desired port number. The single quotes should not be removed or changed.

For previous versions of the software, the ansoftrsmservice.cfg file may not contain the lines:

$begin 'Default:CommDetails'

$begin 'CommDetails'

'ListenPort'='32958'

$end 'CommDetails'

$end 'Default:CommDetails'

If these lines are not present, then add them to the ansoftrsmservice.cfg file after the first line of
the file, and change the ListenPort to the desired port number. For example, to change the port
number to 32000, the beginning of the ansoftrsmservice.cfg file should look like the following
after the changes:

$begin 'AnsoftCOMDaemon'

$begin 'Default:CommDetails'

$begin 'CommDetails'

'ListenPort'='32958'

$end 'CommDetails'

$end 'Default:CommDetails'

Ansys Electromagnetics Desktop Configuration

The port number for connecting to the RSM service is configured using theGeneral Options
window (Tools > Options > General Options). From the left pane, select Remote Analysis to
view RSM Service Options.
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Click Change to open the Change Ansoft Service Port dialog box.

Enter a new port number and clickOK.
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Supported Job Schedulers
Supported job schedulers are listed at the Ansys Platform Support page:

https://www.ansys.com/Solutions/Solutions-by-Role/IT-Professionals/Platform-Support

Versions earlier than the latest tested version indicated may work and may have been tested in
previous versions of the product. Newer versions may also work if backward compatibility is
maintained by the scheduler.

This document covers the Windows HPC and IBM Spectrum LSF schedulers.

Custom Scheduler Integration
For supported job schedulers in a standard configuration, Ansys Electromagnetics products
provide an out-of-the-box integrated solution. For integration with other schedulers or non-
standard scheduler configurations, users (or scheduler vendors) can provide a component
called "custom scheduler proxy." Using this small component, AnsysEMmainly identifies the
compute nodes allocated by a scheduler to the AnsysEM job, and launches solver processes on
those nodes.

A custom scheduler proxy is usually an IronPython script file that has a class that implements a
specified interface. Functionally, the methods of this class mediate the interactions between
AnsysEM processes and the scheduler. Physically, such a proxy is a small text file, and does not
require to be compiled/linked. This is often the preferred approach, as it is easier to install and
test. The details of this interface and its methods are described elsewhere. Installing a custom
scheduler proxy usually means just adding a .py file under schedulers subdirectory of the
AnsysEM installation directory. By providing a custom scheduler proxy written in IronPython, you
can even override the default scheduler proxy for a supported scheduler.

Note:

IronPython is an implementation of the Python programming language targeting the
.NET runtime. You do not need to install IronPython, as AnsysEM already comes with
IronPython. AnsysEM supports it on both Windows and Linux. For more information,
see the Scripting section of the online help.

Alternately, a custom scheduler proxy can be a dynamically linked library (on Microsoft
Windows) that implements a set of functions. This library is loaded by AnsysEM at runtime, and if
it is running as part of a scheduler job, the AnsysEM interacts with the library to get information
from the scheduler, and to start additional processes on specified hosts. Each such library
implements a set of extern "C" functions needed to mediate the interactions between AnsysEM
and the scheduler.
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Limitations
Implementing your own custom scheduler proxy does not allow use of the job management GUI.
It also does not provide tight-integration of scheduler for MPI-based jobs.

Running HPC Test Jobs on a Cluster
This section describes how to submit and run a small number of test jobs to verify that the
product installation, the cluster configuration, and the MPI installation and configuration are
satisfactory for running Ansys Electromagnetics analysis jobs. These tests are not
comprehensive, but successful completion of all of the jobs indicates that the basic requirements
for running Ansys Electromagnetics jobs have been met.

Before running these tests, the following steps should be completed:

l Ansys Electromagnetics product(s) should be installed.
l The cluster should be configured for running jobs, as described in Scheduler-Specific
Configuration and Testing (Page 3-22).

l MPI should be installed and configured, as described in MPI Installation (Page 5-1).

Each of the test jobs should run to completion in a few minutes or less. They should be run in the
order specified, proceeding to the next test only if any problems found in the preceding test have
been addressed.

Background: Selecting a Scheduler
The test jobs in this section may be submitted to a cluster using the Electronics Desktop job
submission GUI.

1. Launch Ansys Electronics Desktop on a host that is configured as a submission host for
the cluster.

2. Click Tools > Job Management > Select Scheduler.

The Select Scheduler window appears.

3. For a Windows HPC cluster, use the Select scheduler drop-down menu to select
Windows HPC. In the Head Node field, type the name of a computer or click the ellipses
(...) button to view a list of accessible computers in the network.

For information about selecting other types of clusters (for example, LSF), consult the
HPC Administrator User's Guide.

4. Click Refresh to verify the connection to the cluster.

The Scheduler Info field updates with this information.
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Test #1: Submitting and Running a Non-distributed Job
This is a simple job that uses one core on one host. This test uses the Tee.aedt example project,
which is located in the Examples/HFSS/RF Microwave subdirectory of the product installation
directory. The file Tee.aedt is needed for this test. This test uses Setup1, but it does not use the
frequency sweep, Sweep1, so the frequency sweep must be disabled.

Successful completion of this job indicates that the following requirements have been met:

l The job submission host is correctly configured for submitting jobs to the cluster.
l The job user account is authorized to run jobs on the cluster.
l The product installation is accessible from the cluster host allocated to the job.
l The project directory is accessible from the cluster host allocated to the job.
l Communication between different job processes on the cluster host allocated to the job is
not blocked.

Perform the following steps:

1. Copy the file Tee.aedt from <InstallationDirectory>/Examples/HFSS/RF Microwave
subdirectory of the product installation directory to another directory.

2. Launch Ansys Electronics Desktop.
3. Open the copy of the project.
4. In the Project Manager, expand TeeModel (Driven Model) > Analysis > Setup1>

Sweep1. If frequency sweep Sweep1 is enabled, right-click it and select Disable Sweep.
5. Click Tools > Job Management > Submit Job.

The Submit Job To window appears, on the Analysis Specification tab.

6. Ensure the Product path contains a path that is valid for the cluster execution nodes.
7. In the Analysis Setups area, select Single Setup. Use the drop-down menu to select

TeeModel:Nominal:Setup1.
8. Click the Compute Resources tab to view additional options.
9. Deselect Use automatic settings, and set the following:

l ForMethod, use the drop-down menu to select Number of Tasks and Cores.
l Set the Total number of tasks to 1.
l Set the Cores per distributed task to 1.
l Ensure that the Limit number of tasks per node to: check box is deselected.

10. Ignore any other settings, and click Preview Submission.

A preview window appears. If no errors are found, the preview should display information
on how the job will be submitted to the cluster. If an error appears, address the error
before continuing. The preview should indicate that only one host is needed for the job. If
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this is not the case, review the job resources specified on the Compute Resources tab
and retry. If the job and task parameters are correct, close preview window and continue.

11. Click Submit Job.

If an error occurs on job submission, address the error before submitting the job again. If
you are prompted for a password, enter it and continue. If possible, monitor the job until it
finishes.

12. Save and close the project.

If the job fails to complete successfully, check the following items:

l The user submitting the job must be authorized to run jobs on the cluster.
l The path name of the product must be accessible on the cluster execution node(s) where
the job runs, and the user must have permission to run the product executables.

l The path name of the project must be accessible on the cluster execution node(s) where
the job runs.

l The job user must have permission to read from and write to the directory containing the
project file, and there must be adequate disk space for the job results.

l The temporary directory used by the job must exist and it must have adequate disk space
for the job temporary files.

l Check for errors or warnings in theMonitor Job dialog box, and address these issues.
l Check the cluster for errors or warnings related to the job and address these issues. The
job ID is displayed in a dialog when the job is successfully submitted. The job ID of the last
job run on the specified project is also shown in theMonitor Job dialog box.

Test #2: Submitting and Running a Non-MPI Job Distributed
to Multiple Hosts
This job uses multiple cores distributed to multiple hosts. It does not use MPI. This job will start
on one host, but portions of the analysis will be distributed to the other hosts allocated to the job.
This test uses the Tee.aedt example project, which is located in the Examples/HFSS/RF
Microwave subdirectory of the product installation directory. This test uses Setup1, and it uses
the frequency sweep Sweep1, so frequency sweep must be enabled.

The cluster must have at least two hosts with the same number of cores per host. Let N be the
smallest number of cores per host, such that the cluster contains at least two hosts with N cores
per host. The job will be submitted to run on two hosts with N cores per host, requesting a total of
2 * N cores. For many clusters, selecting N = 4 may be a good choice.

Successful completion of this job indicates that the following additional requirements have been
met:
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l A job process on one cluster host allocated to the job is able to use the cluster to start
additional job processes on other cluster hosts allocated to the job.

l Communication between job processes running on different cluster hosts allocated to the
job is not blocked.

Perform the following steps:

1. Copy the file Tee.aedt from <InstallationDirectory>/Examples/HFSS/RF Microwave to
another directory.

2. Launch Ansys Electronics Desktop.
3. Open Tee.aedt.
4. In the Project Manager, expand TeeModel (Driven Model) > Analysis > Setup1 >

Sweep1. If frequency sweep Sweep1 is disabled, right click it and select Enable Sweep.
5. Click Tools > Job Management > Submit Job.

The Submit Job To window appears, on the Analysis Specification tab.

6. Ensure the Product path contains a path that is valid for the cluster execution nodes.
7. In the Analysis Setups area, select Single Setup. Use the drop-down menu to select

TeeModel:Nominal:Setup1.
8. Click the Compute Resources tab to view additional options.
9. Deselect Use automatic settings, and set the following:

l ForMethod, use the drop-down menu to select Number of Tasks and Cores.
l Set the Total number of tasks to 2 * N.
l Set the Cores per distributed task to 1.
l Ensure that the Limit number of tasks per node to: check box is deselected.
l In the Job distribution group box, press theModify button to access the Job
Distribution dialog box.

l In the Enable Distribution Types section, deselect the Use defaults check box, and
select only the Frequencies check box.

l In the Distribution levels section, select the Single level only radio button.
l ClickOK to close the Job Distribution dialog box.

10. For the schedulers:
l Click the ellipses (...) button to open the Compute Resource Selection Parameters
dialog box.

l ForMinCoresPerNode , select Specify Parameter and set the value to N.
l ForMaxCoresPerNode, select Specify Parameter and set the value to N.
l ClickOK to close the Compute Resource Selection Parameters dialog box.
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11. Ignore any other settings, and click Preview Submission.

A preview window appears. If no errors are found, the preview should display information
on how the job will be submitted to the cluster. If an error appears, address the error
before continuing. This preview should indicate that a total of 2 * N cores are required for
the job, and that N cores will be needed on each host allocated to the job. If this is not the
case, review the job resources specified on the Compute Resources tab and retry. If the
job and task parameters are correct, close the preview window and continue.

12. Click Submit Job.

If an error occurs on job submission, address the error before submitting the job again. If
you are prompted for a password, enter it and continue. If possible, monitor the job until it
finishes.

13. Save and close the project.

If the job fails to complete successfully, check the following items, in addition to the items
mentioned for the first test:

l The Desktop process will use the cluster to launch processes on the other hosts allocated
to the job. Verify that the cluster configuration allows a job to launch processes on the
other hosts allocated to the job.

l Job processes on different hosts allocated to the job need to communicate. Verify that
communication between these job processes is not blocked.

Test #3: Submitting and Running an MPI Job Distributed to
Multiple Hosts
This job uses MPI processes distributed to multiple hosts. This job will start on one host, but
portions of the analysis will be distributed to MPI ranks running on the first execution host and
ranks running on other hosts allocated to the job. This test uses the differential_stripline.aedt
example project, which is located in the Examples/HFSS/Transmission Lines subdirectory of the
product installation directory. The file differential_stripline.aedt is needed for this test. This test
uses Setup1, but does not use the frequency sweep, DC_10GHz. The frequency sweep must be
disabled.

Determine which MPI Vendor will be used for MPI jobs, Intel MPI or Microsoft MPI. This test
should use the same MPI Vendor that will be used by cluster users. If no MPI Vendor is specified
by the user, then the default MPI Vendor (Microsoft) is used. Intel MPI is denoted by the string
“Intel.” Microsoft MPI is denoted by the string “Microsoft.” If both MPI Vendors may be needed by
cluster users, then this test should be run twice, once with each MPI Vendor specified. Consult
MPI Installation (Page 5-1) to determine whether the MPI provided by the selected MPI Vendor
needs to be installed and to determine how it should be configured.

The cluster must have at least two hosts with the same number of cores per host. Let N be the
smallest number of cores per host, such that the cluster contains at least two hosts with N cores
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per host. The job will be submitted to run on two hosts with N cores per host, requesting a total of
2 * N cores.

Successful completion of this job indicates that the following additional requirements have been
met:

l MPI is installed and configured on the cluster hosts.
l User passwords are registered with MPI on the cluster hosts.
l MPI prerequisites are installed on the cluster hosts.

Perform the following steps:

1. Copy the file differential_stripline.aedt from
<InstallationDirectory>/Examples/HFSS/Transmission Lines to another directory.

2. Launch Ansys Electronics Desktop.
3. Open differential_stripline.aedt.
4. In the Project Manager window, expand differential_stripline > Differential Stripline

(Driven Terminal) > Analysis >GHz > DC_10GHz. If frequency sweep DC_10GHz is
enabled, right-click it and select Disable Sweep.

5. Click Tools > Job Management > Submit Job.

The Submit Job To window appears, on the Analysis Specification tab.

6. Ensure the Product path contains a path that is valid for the cluster execution nodes.
7. In the Analysis Setups area, select Single Setup. Use the drop-down menu to select

Stripline:Nominal:3GHz.
8. Under Analysis Options, set the HFSS/MPIVendor batchoption to the desired MPI

Vendor, either Intel orMicrosoft. If this batchoption is not present, click Add to open the
Add Batchoption dialog box. Locate HFSS/MPIVendor in the list, select it, and click
Add.

9. Click the Compute Resources tab to view additional options.
10. Deselect Use automatic settings, and set the following:

l ForMethod, use the drop-down menu to select Number of Tasks and Cores.
l Set the Total number of tasks to 2 * N.
l Set the Cores per distributed task to 1.
l Ensure that the Limit number of tasks per node to: check box is deselected.
l In the Job distribution group box, press theModify button to access the Job
Distribution dialog box.

l In the Enable Distribution Types section, deselect the Use defaults check box, and
select only the Direct Solver Memory check box.

l In the Distribution levels section, select the Single level only radio button.
l ClickOK to close the Job Distribution dialog box.
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11. For the schedulers:
l Click the ellipses (...) button to open the Compute Resource Selection Parameters
dialog box.

l ForMinCoresPerNode , select Specify Parameter and set the value to N.
l ForMaxCoresPerNode, select Specify Parameter and set the value to N.
l ClickOK to close the Compute Resource Selection Parameters dialog box.

12. Ignore any other settings, and click Preview Submission.

A preview window appears. If no errors are found, the preview should display information
on how the job will be submitted to the cluster. If an error appears, address the error
before continuing. This preview should indicate that a total of 2 * N cores are required for
the job, and that N cores will be needed on each host allocated to the job. If this is not the
case, review the job resources specified on the Compute Resources tab and retry. If the
job and task parameters are correct, close the preview window and continue.

13. Click Submit Job.

If an error occurs on job submission, address the error before submitting the job again. If
you are prompted for a password, enter it and continue. If possible, monitor the job until it
finishes.

14. Save and close the project.

If the job fails to complete successfully, in addition to the items mentioned for the first and
second tests, MPI configuration issues may cause job failures. Check the following MPI
configuration issues:

l Verify that the correct MPI Vendor (“Intel” or “Microsoft”) is specified using a batchoption
setting in the Submit Job To: dialog box. The controls for specifying batchoptions are
located on the Analysis Specification tab, under Analysis Options.

l Verify that the specified MPI Vendor is installed (if needed) and configured correctly for
the user submitting the job, as described in MPI Installation (Page 5-1). Pay close
attention to the registration of user passwords because the lack of a cached password
when one is required, or a cached password that is incorrect or out of date (even if no
cached password is required) may cause authentication errors. Note that passwords are
cached separately on each cluster host, so a job may have authentication errors on some
hosts but not on other hosts.

Scheduler-Specific Configuration and Testing
As a companion to the scheduler tests above, the sections below describe configuration
requirements for the Windows HPC and IBM Spectrum LSF schedulers.

For integration with Linux schedulers, consult the Ansys Electromagnetics Suite 2024 R2
Unix/Linux Installation Guide.
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For integration with third party or custom schedulers, consult the Ansys Electronics online help.

Windows HPC Scheduler

Job Submission Host Configuration

In order to submit jobs to a Windows HPC cluster from the Ansys Electronics Desktop
application, Windows HPC Client Utilities must be installed on the job submission host. The
recommended version is Microsoft (R) HPC Pack 2019. Only the Client Components are
required on the job submission host.

The Bin subdirectory of the Windows HPC Client Utilities installation directory (typically
"C:\Program Files\Microsoft HPC Pack 2019\Bin") must be included in the PATH environment
variable or in the ANSYSEM_WINHPC_CLIENT_UTILS_PATH environment variable. If this
folder is not added to the PATH environment variable during the installation of the Client Utilities,
or if it has been removed from the PATH environment variable, then it may need to be manually
added to one of these environment variables. The ANSYSEM_WINHPC_CLIENT_UTILS_
PATH environment variable may be used instead of the PATH environment variable to prevent
the PATH environment variable from becoming too long. The ANSYSEM_WINHPC_CLIENT_
UTILS_PATH environment variable may contain multiple directories separated by semicolon (;)
characters, just like the PATH environment variable.

Cluster Configuration Guidelines

TheWindows HPC cluster affinity setting should be set to “Non-Exclusive jobs” or “No jobs.”
Setting the Windows HPC cluster affinity to “All jobs” may prevent the job from using all of the
resources allocated to the job, for the reasons outlined below.

Each Ansys Electromagnetics analysis job is started as a single process on a single host. If the
job needs to distribute a portion of the analysis to a different host, a single core task is started on
the remote host to start the analysis processes on that host. Only one core is allocated for the
task used to start these processes, even if multiple process are started by the task or multiple
cores are needed by any of the processes started by the task. If the Windows HPC cluster
affinity setting is set to “All jobs,” then the remote processes would be limited to using a single
core on the remote host, even if the job was allocated multiple cores on the remote host.

Running Test Jobs

When attempting to submit a job to the cluster, if there is a problem connecting to the head node,
check the following items:

l The head node name is correct.
l There is a network connection between the job submission node and the head node.
l No firewall blocks communication between the job submission node and the head node.
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l Windows HPC Server 2008 R2 (or later) client utilities are installed on the job submission
node.

l The user making the connection is an authorized Windows HPC cluster user.

If the job cannot be monitored from the Ansys ElectromagneticsMonitor Job window because
there is no network connection between the submission node and the cluster execution node (or
the connection is blocked), then the HPC Job Manager installed with Windows HPC Client
Utilities can be used to monitor the job.

If errors occur with any of the test jobs, then information on the failure can be found by viewing
the job in the HPC Job Manager. Check for messages in the Job Progress window. For any
failed tasks, check the Results, Details, and Allocated Nodes tabs for more information on
possible problems.

Non-distributed job

If the job fails to complete successfully, check the following items:

l The user submitting the job must be authorized to run jobs on the cluster.
l The pathname of the product must be accessible by the user running the job from the
cluster execution node(s) where the job runs.

l The pathname of the project must be accessible by the user running the job from the
cluster execution node(s) where the job runs. The directory containing the project file must
be writable by the user running the job from the cluster execution node(s) where the job
runs, and there must be adequate disk space for the job results.

l The temp directory specified by batchoptions or using the installation default setting on
the cluster execution node(s) where the job runs must have adequate disk space for the
job temporary files.

l Check for errors or warnings in Electronics Desktop'sMonitor Job window, and address
these issues.

l Also check the Job using theWindows HPC Job Manager. Check for error and warning
messages associated with the job. Also check for failed tasks, and check the task
information for any failed tasks.

Non-MPI job distributed to multiple hosts

This job will be submitted to run on two hosts with N cores per host, requesting a total of 2 * N
cores, where N is the smallest number of cores per host, such that the cluster contains at least
two hosts with N cores per host.

If the job fails to complete successfully, check the following items, in addition to the items
mentioned for the first test:

l In addition to the task used to start the job (the Desktop task), an additional task is started
each of the other job hosts to start processes on these hosts. For this task, there should
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be one such task (a Remote Engine Task). Verify that the Remote Engine Task is able to
start and communicate with the Desktop task.

MPI job distributed to multiple hosts

This job will be submitted to run on two hosts with N cores per host, requesting a total of 2 * N
cores, where N is the smallest number of cores per host, such that the cluster contains at least
two hosts with N cores per host.

If the MPI Vendor is “Intel,” then installation of Intel MPI on all cluster nodes is required as
described in MPI Installation (Page 5-1).

If the job fails to complete successfully, in addition to the items mentioned for the first and
second tests, MPI configuration issues may cause job failures. Check the following MPI
configuration issues:

l Verify that the correct MPI Vendor (“Microsoft”) is specified via a batchoption setting when
submitting the job.

l Verify that the specified MPI Vendor is installed and configured correctly for the user
submitting the job, as described in MPI Installation (Page 5-1). Note that MPI password
registration is done separately for each cluster host. If authentication errors occur for
some cluster hosts but not for other cluster hosts, then the errors may be due to an
incorrect password or no password registered on some hosts.

IBM Spectrum LSF Scheduler

Cluster Configuration Guidelines

To allow users to submit exclusive jobs, the users must have access to queues which are
configured with the EXCLUSIVE property set to Y. Appropriate queues should be configured
with the EXCLUSIVE property set if users need to submit exclusive jobs.

Using the Ansys Electromagnetics job submission GUI, a user may submit jobs where the user
specifies tasks automatically and specifies the “Number of Cores and (Optional) RAM.”
However, the RAM per core may only be specified if the LSF cluster is configured with parameter
RESOURCE_RESERVE_PER_SLOT set. This LSF cluster configuration parameter should be
set to allow user to specify the RAM per core for the job.

Running Test Jobs

If there is a problem connecting to the scheduler when the job submission node is the local node
(where the GUI is running) and the lsf scheduler is specified, check the following items:

l The cluster is up and running normally.
l The local node is configured as a job submission node for the cluster.
l The user running the GUI has permission to submit jobs to the cluster.
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l The environment was configured for submission of jobs to the cluster before starting the
product, ansysedt.

Non distributed job

l If the job fails to complete successfully, check the following items:
l The user submitting the job must be authorized to run jobs on the cluster.
l The pathname of the product must be accessible by the user running the job from the
cluster execution node(s) where the job runs.

l The pathname of the project must be accessible by the user running the job from the
cluster execution node(s) where the job runs. The directory containing the project file must
be writable by the user running the job from the cluster execution node(s) where the job
runs, and there must be adequate disk space for the job results.

l The temp directory specified by batchoptions or using the installation default setting on
the cluster execution node(s) where the job runs must have adequate disk space for the
job temporary files.

l Check for errors or warnings in theMonitor Job dialog box, and address these issues.

Non-MPI job distributed to multiple hosts

This job is submitted to run on two hosts with N cores per host, requesting a total of 2 * N cores,
where N is the smallest number of cores per host, such that the cluster contains at least two
hosts with N cores per host.

For this test, the product, ansysedt, runs on one of the hosts, and the LSF blaunch command is
used to start an ansoftrsm process on the other host. The ansoftrsm process is used to start any
additional processes needed by the job on the other host. In some cases, multiple ansoftrsm
processes are started on the other host, but only one such process should be running on a given
host at any time.

If the job fails to complete successfully, check the following items, in addition to the items
mentioned for the first test:

l Verify that the LSF blaunch command is able to start the ansoftrsm process on the other
host.

MPI job distributed to multiple hosts

This job is submitted to run on two hosts with N cores per host, requesting a total of 2 * N cores,
where N is the smallest number of cores per host, such that the cluster contains at least two
hosts with N cores per host.

If the MPI Vendor is “Intel,” then installation of Intel MPI on all cluster nodes is required as
described in If the job fails to complete successfully, in addition to the items mentioned for the
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first and second tests, MPI configuration issues may cause job failures. Check the following MPI
configuration issues:

l Verify that the correct MPI Vendor (“Intel”) is specified via a batchoption setting when
submitting the job.

l Verify that the specified MPI Vendor is installed and configured correctly for the user
submitting the job, as described in MPI Installation (Page 5-1). MPI password registration
is done separately for each cluster host. If authentication errors occur for some cluster
hosts but not for other cluster hosts, then the errors may be due to an incorrect password
or no password registered on some hosts.
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4 - Updating Software and Licenses
After installation, you may need to reinstall the software, update a license, or add a software
component, such as a library. If you have already installed the software, the next time you run
the Setup program, the installation starts inMaintenance Mode.

Using Maintenance Mode
The following options are available inMaintenance Mode:

l Modify – allows you to modify the existing installation. Use this option to select new
software components or to select a new license file.

l Repair – upgrades the existing software with new features and defect patches and
refreshes files.

l Remove – removes all installed software components.
l Update/Remove – displays only if the version you are installing is newer than the current
installation.)

To start the Ansys Electromagnetics Suite Installation Wizard inMaintenance Mode:

1. FromWindows, access the list of Programs and Features.

Steps for doing so vary, depending on your version of Windows. Consult Microsoft
Windows help.

2. From the list of applications, click the applicable Ansys Electromagnetics product.
3. Click Change.

TheModify, Repair, or Remove window appears.
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4. Select the desired option from: Modify, Repair, Remove, and Update/Remove (if
available).

Updating a License
There may be times when you need to update a license. Most often, this happens when you
change license servers.

When you receive a new license file:

If you receive an updated purchased license file, you need only update the license file using
Ansys License Manager.

When you change license servers:

1. Install Ansys License Manager on the new server machine, and add the new license file.
2. Run each Ansys Electromagnetics Suite installation in Maintenance Mode, and specify

the names of the new servers.

When changing the name of the license server:

When changing the name of the license server used by the software, you need to modify the
client installation:
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1. Run Maintenance Mode.
2. ClickModify.
3. Click Next on each screen to move through the steps.
4. On the License Information screen, select the new license file.

l If you received a new file from Ansys evaluation or purchase, select I have a new
license file.

l If you need to change the name of the machine where Ansys License Manager is
installed, select I want to specify a license server.

See: Installing the Software (Page 2-1).

Specifying License Server Machines via ansyslmd.ini or
Environment Variables
Specifying the license server during installation creates or updates the ansyslmd.ini file
located in the licensing directory. Entries in this file tell Ansys products which license server(s) to
query to find a valid license. This allows all users at your site to use this setting without having to
individually set the ANSYSLMD_LICENSE_FILE or ANSYSLI_SERVERS environment
variables to specify the license server machine(s). It also eliminates the need to have a copy of
the license file on every system at your site.

The order that the SERVER lines are listed in ansyslmd.ini dictates the order in which the
license request is granted. To reorder the entries in the list, highlight a server and use theMove
up orMove down buttons.

Administrators are not limited to designating one set of license server machines for a network.
A network can have multiple single-server or three-server (redundant triad) licensing systems. In
this situation, you would have certain licenses connected to a set of server machines (one or
three) on the network, and other licenses connected to a different set of server machines (one or
three) on the network.

The format of the ansyslmd.ini file created by ANSLIC_ADMIN follows. Each server's
specification entry in this file will typically begin with ANSYSLI_SERVERS= and SERVER= to
specify the Licensing Interconnect and FlexNet port numbers, respectively.

On a single server:

ANSYSLI_SERVERS=<ansysliport>@<host>

SERVER=<flexnetport>@<host

For multiple single servers:

Each server should have its own ANSYSLI_SERVERS= and SERVER= lines.
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On redundant (triad) servers on Windows platforms:

Windows uses semicolons (;) to separate servers:

ANSYSLI_SERVERS=<ansysliport>@<host1>;<ansysliport>@<host2>;
<ansysliport>@<host3>

SERVER=<flexnetport>@<host1>;<flexnetport>@<host2>;
<flexnetport>@<host3>

Important:

Do not use commas as separators. Use semicolons (;) on Windows machines, and
colons (:) on Linux machines.

The Ansys Licensing Interconnect default port number is 2325 and the Ansys FlexNet default
port number is 1055. The host is the license server hostname.

For example, if the license server name is alpha1:

ANSYSLI_SERVERS=2325@alpha1

SERVER=1055@alpha1

The order of the ANSYSLI_SERVERS and the SERVER lines in the ansyslmd.ini file specifies
the order in which the requested license will be granted.

You must use the port@host format; you cannot enter a path or a filename in place of the
hostname.

Overriding the ansyslmd.ini File:

If you want to override the server specification settings in the ansyslmd.ini file, you can do so
by setting the ANSYSLMD_LICENSE_FILE and ANSYSLI_SERVERS environment variables
on individual machines. These environment variables are useful if you want to temporarily point
to a different license server machine without disrupting the machine's configuration.

l ANSYSLI_SERVERS – specifies the Licensing Interconnect port number.
l ANSYSLMD_LICENSE_FILE – specifies the FlexPort port number.

If the ANSYSLMD_LICENSE_FILE environment variable is set but the ANSYSLI_SERVERS
environment variable is not set, the same server machines will be used to specify the Licensing
Interconnect but the port number will be replaced by the Licensing Interconnect default port of
2325.

When both variables are set, ANSYSLMD_LICENSE_FILE explicitly defines the FlexNet
servers while ANSYSLI_SERVERS explicitly defines the Licensing Interconnect servers.
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If you set the ANSYSLMD_LICENSE_FILE or ANSYSLI_SERVERS environment variables on
a three-server (redundant) system, specify all three systems in the same order as the SERVER
lines are listed in the license file. If you specify only the primary server and it is down, you could
see a “License Server Down” or “No License Found” message and the search for a license could
fail. Join redundant or multiple single-server systems by separating the system names with
semicolons onWindows systems.
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5 - Message Passing Interface (MPI)
Installation

The two supported Message Passing Interface (MPI) options in Ansys Electromagnetics Suite
are Microsoft and Intel. MPI is not required if an analysis is not distributed, nor is it required for
manual distribution of variations only. MPI is required for all other types of distribution, such as
distribution of frequencies or domains and for auto distribution.

Intel MPI
For Intel MPI, user authorization must be configured to distribute an analysis using MPI. Intel
MPI supports several authentication methods onWindows, including password-based
authorization. Consult Intel MPI documentation on user authorization for additional information.

No additional MPI configuration is required for distribution using Intel MPI on the local host.

For distribution using Intel MPI to multiple hosts, Intel MPI must be installed on all of the hosts
and the Hydra Service must be running on all of the hosts in addition to configuring user
authorization on all of the hosts.

Installing Intel MPI
To install Intel MPI, perform the following steps:

1. Launch the Ansys Electromagnetics Installation Shell:
l If you have a physical disc, it will launch automatically. If it does not, locate the drive and
launch autorun.exe.

l If you downloaded a digital copy, unzip the download and launch autorun.exe.
2. Click Install Distributed Simulation Technologies.
3. Under MPI, click Install Intel MPI.

The Intel MPI Library... dialog box appears.
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4. Specify a directory, and click Extract.

The Intel MPI Library Update window appears.

5. Click Next to install the software.

Intel MPI typically requires passwords to be registered on the simulation host machine,
which is typically the first machine in the distributed machine list. Password registration
may also be required on other machines to allow access to network resources, such as
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shared drives. Launch the Intel MPI Library Runtime Environment for Windows to set
username and password.

Note:

You can work around the password registration for cases where accessing
network resources is not needed by performing the Active Directory setup and
setting the environment variable I_MPI_AUTH_METHOD to "delegate".

Consult Intel documentation: https://software.intel.com/en-us/mpi-developer-
reference-windows-user-authorization

6. Click Finish.

Microsoft MPI
For Microsoft MPI, no configuration of user authorization is required.

For Windows HPC jobs, no additional configuration is required for distribution using Microsoft
MPI.

For distribution using Microsoft MPI on the local host (without Windows HPC), some additional
configuration is required. Microsoft MPI must be installed on the local host and the MS-MPI
Launch Service must be running. The Microsoft MPI redistributable package installs the MS-MPI
Launch Service, with the startup type set to Manual, so the MS-MPI Launch Service must be
started manually. This may be done using the Windows Services Manager or using the
command line as described in the Microsoft MPI Release Notes. Distribution to multiple hosts
using Microsoft MPI is only supported under Windows HPC.

Installing Microsoft MPI
In order to use Microsoft MPI with Ansys EM Suite on the local host, Microsoft MPI must be
installed on the local host and the MS-MPI Launch Service must be running.

To install Microsoft MPI:

1. Launch the Ansys Electromagnetics Installation Shell:
l If you have a physical disc, it will launch automatically. If it does not, locate the drive and
launch autorun.exe.

l If you downloaded a digital copy, unzip the download and launch autorun.exe.
2. Click Install Distributed Simulation Technologies.
3. Under MPI, click Install Microsoft MPI.

TheMicrosoft MPI Setup Wizard launches.

MPI Installation 5-3

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.

https://software.intel.com/en-us/mpi-developer-reference-windows-user-authorization
https://software.intel.com/en-us/mpi-developer-reference-windows-user-authorization


Ansys Electromagnetics Suite 2024 R2Windows Installation Guide

4. Click Next.

The End-User License Agreement appears.
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5. Select the check box to agree with the terms, then click Next.

The Destination Folder selection screen appears.
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6. Select a destination folder, and click Next.

The wizard is ready to install.
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7. Click Install.

A progress bar shows installation progress.
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When installation completes, a success message appears.
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8. Click Finish to close the wizard.

MS-MPI Launch Service

You can use MS-MPI Launch Service to launch MPI processes for local and remote machines.

For more information, refer to Microsoft MPI Release Notes for MS-MPI Launch Service.

Selecting an MPI Vendor in Ansys
Electronics Desktop
To select which MPI to use:

1. Launch Ansys Electronics Desktop.
2. Click Tools > Options > HPC and Analysis Options.
3. On theOptions tab, click theMPI Vendor field and select either Intel orMicrosoft.
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Important:

In order to use Intel MPI, you will first need to:

l Edit permissions for the temp directory on all machines so that the designated
user is allowed full control.

l Disable the Windows firewall, or configure it as specified in the Firewall
Configuration topic in the Ansys Electronics online help.

MPI Notes and Example Scenarios
Using network resources, such as shared drives, may require password registration on all
machines for both Microsoft and Intel MPI.

It is easiest if share permissions are set to Full Control for the Everyone group for the temp
directories.

Some example scenarios follow.

Note:

The scenarios described here assume that the user is part of a domain and is running
on computers within the given domain.

Scenario #1: Local User Exists on All Machines
The user is an admin or standard user on the local machine and needs to run as an admin or
standard user on one or more remote machines. The user always puts the local machine first in
the distributed machine list so that the local machine is the simulation host.

This is the standard situation and does not require further specifications. MPI should be installed
on all machines, and the solver options and MPI configuration on the local machine will be used.

Scenario #2: Local User Doesn't Exist on Remote Machine(s)
The user is an admin or standard user on the local machine, but is not defined as a user on the
remote machine(s). The user always puts the local machine first in the distributed machine list so
that the local machine is the host.

This situation is similar to Scenario #1, but MPI jobs will run as a user that does not exist on the
remote machine(s). Ansys strongly recommends setting the temp directories to Full Control for
the Everyone group to avoid issues with permissions.
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Scenario #3: Local User Only Runs Remote Machine(s)
The user is an admin or standard user on the local machine, but only needs to run jobs on
remote machine(s). In this scenario, the remote machine that is first in the distributed machine
list will be the host machine for the simulation.

RSMmust be installed and registered on the host machine. There are two RSM settings that can
affect the simulation.

l The first setting is under RSM properties, which can be set to System User or A
specific user. This setting is chosen at installation and can be changed through the
Services panel or by going to Remote Simulation Manager > Remote Simulation
Manager Maintenance >Modify.

l The second setting is in the Desktop in Tools >Options >General Options, on the
Remote Analysis Options tab. Here you can chose either Service User or Specified
User. Here is additional information about these settings:

RSM Properties Remote Simulation
Options

Simulation runs on remote
machine as Notes

System Service User Local System user Local System
user will not have
Ansys
Electromagnetics
Suite user
preferences and
may not have
necessary
privileges or
access to
resources.

System Specified User =
user_A

user_A Runs as user_A

Specific User =
user_A

Service User user_A Runs as user_A

Specific User =
user_A

Specified User =
user_B

May fail due to privileges Not
recommended

The preferred setup for this situation is to assign a Specific or Specified user, but not both.

Windows HPC Scheduler
When using the Windows HPC Scheduler, you have the option to install the Ansys
Electromagnetics Suite at the same location on each node individually. The simulation can then
be run from one of the compute nodes or from the head node using the Windows HPC

MPI Installation 5-11

Ansys Electromagnetics Suite 2024 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Ansys Electromagnetics Suite 2024 R2Windows Installation Guide

Scheduler GUI that is selected in Tools > Job Management > Select Scheduler before using
Tools > Job Management > Submit Job. The MPI setup is the same as described previously.
If a registered password expires or is changed for any other reason, then MPI failures may occur
due to the incorrect password.

To use a command window to clear a previously registered password:

Go to <install_dir>\win64\common\fluent_
mpi\multiport\mpi\win64\pcmpi\bin and run the following command:

mpidiag -s <your machine name> -at -clearcache

The following command may be used to check whether a password is cached for the current
user:

mpidiag -s <your machine name> -at -iscached

For general information on using the Windows Scheduler, see the Integration with Microsoft
Windows HPC Scheduler topic in the Ansys Electromagnetics Suite online help.

Note:

The LSF scheduler is not supported onWindows networks for Ansys Electromagnetics
Suite simulations that require MPI (for example, DDM).

Network Installation with Windows HPC
To use a network installation with the Windows HPC Scheduler:

1. Install Ansys Electromagnetics Suite on the head node.
2. Share the /AnsysEM directory in the head node installation, setting Full Control for

Everyone.
3. Install Intel MPI on all nodes.

Ensure that:

l Password is registered with MPI on all nodes.
l Active Directory is set up on all nodes.

Consult Intel MPI online help: 
https://www.intel.com/content/www/us/en/developer/tools/oneapi/mpi-library.html
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Note:

Password registration is not required for Windows HPC jobs.

Before submitting a job, consult the online help for information on using MPI-
based solves.

4. Install the following Microsoft Visual C++ Redistributable on all nodes:
l Microsoft Visual C++ 2015-2019 (x86 and x64)

The necessary installers are provided in the installation folder.

5. Verify installation was done correctly by launching Ansys Electronics Desktop on each
node using the network installation.

6. Place the pjt file in a shared folder (one where Everyone has Full Control).
7. Launch Ansys Electronics Desktop on the head node.

Set the head node in Electronics Desktop:

l Tools > Job Management > Select Scheduler.
8. Open the Windows Scheduler GUI and submit the job.

From Electronics Desktop:

l Tools > Job Management > Submit Job.

For more information onWindows HPC Schedulers, consult the Ansys Electronics online
help.

9. Ensure you are using the UNC pathname for the product and project.
10. Create and set up a job, as desired.

Ansys recommends setting the MPI version using batchoptions. For example:

l 'HFSS/MPIVendor'=Intel

l 'HFSS 3D Layout/MPIVendor'=Intel

l 'Icepak/MPIVendor'=Intel

l 'Maxwell 2D/MPIVendor'=Microsoft

l 'Maxwell 3D/MPIVendor'=Microsoft

l 'Q3D Extractor/MPIVendor'=Microsoft

After the job has been submitted, you can monitor it using HPC Job Manager.

Troubleshooting MPI
This section contains some frequently asked questions and error messages.
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Frequently Asked Questions
Is there an easy way to test the computers in my Distributed Machine Configurations?

Yes. Perform the following steps:

1. Launch Ansys Electronics Desktop.
2. Select Tools > Options > HPC and Analysis Options.
3. Select your configuration from the list and click Edit.
4. Select one or more machines from the list and click Test Machines.

A set of tests will be run from the current machine to selected machine(s). These include pinging
the computer(s) and checking RSM availability.

Why am I getting a password authentication failure?

This may occur if anything changed in your network configuration. The most common cause is
your login password was changed as part of a periodic update for network security. If the
passwords were registered for MPI, they need to be updated on all machines every time the
login passwords are changed.

Error Messages
AnsoftRSMService COM Machine

You may receive the following error at simulation launch:

Unable to locate or start COM engine on <your_machine_name>:

Unable to reach AnsoftRSMService.

Check if the service is running and if the firewall allows
communication…

Do not immediately assume there is a problem with RSM, especially if your_machine_name is
your local machine. Inability to start the COM engine can be the result of a misspelled machine
name or an issue with the firewall. Check these first.

If the host machine is a remote machine (your_machine_name is a remote computer), there
might be an issue with the RSM service on the remote computer. Check the RSM installation
and registration on that machine.

MPI Launch Failure

You may receive the following error during simulation:

The attempted launch of solvers via MPI failed while

connecting to communication pipes. The probable cause

is failure to install the vendor MPI on one or more
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machines or password authentication failure for MPI

during the launch attempt.

This error is often followed by:

Unable to create child process: mpirun

Possible causes include:

l MPI is not installed on one or more machines.
l The wrong version of MPI is installed on one or more machines.
l The password registration is incorrect on one or more machines.
l Ansys Electromagnetics Suite is not installed in the same location on all machines.
l The user is not a registered user on the remote machines for a workgroup network.
l There is an issue with the firewall.

Distributing Matrix Solutions Error

You may receive the following error during simulation:

Distributing matrix solutions for domains, process mpirun error:

Simulation directory creation failed for one or more MPI solvers.

Check access privileges and disk space for the following:

This message means you do not have the correct privilege for the temp directory on one or more
of the remote machines. In many cases the software uses the installation temp directory that is
defined during the installation on the given machine. It is recommended that this directory be set
for Everyone to have full Read/Write privileges on all machines.
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6 - Installing Layout Integrations for ECAD
Layout Integrations for ECAD allow you to incorporate an ALinks module into third-party
PCB/package layout tools. With these integrations installed, you can export salient design
information—such as 2D geometry, layer stackup, and net names—directly into the SIwave user
interface, or as Q3D Extractor or HFSS 3D Layout projects.

To install Layout Integrations for ECAD:

1. Log in as an administrator, or using an account with administrator privileges.
2. Launch the Ansys Electromagnetics Installation Shell:

l If you have a physical disc, it will launch automatically. If it does not, locate the drive and
launch autorun.exe.

l If you downloaded a digital copy, unzip the download and launch autorun.exe.
3. Click Install Layout Integrations for ECAD.

The Installation Wizard appears.

4. Click Next.

A License Agreement appears.
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5. Review the agreement, and click Yes to agree.

The Choose Destination Location window appears.

6. Select an installation directory, and click Next.

A list of Layout Integrations: Automatically Installed appears. These integrations are
pre-selected, and cannot be changed.
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7. Click Next.

A list of Layout Integrations: Optional appears.
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8. Select any integrations you wish to install, and click Next.

The Installation Wizard prompts you to review settings.
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9. Review the settings, and click Next.

A progress bar displays installation progress.
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When installation has finished, a success screen appears.
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If desired, select the check box to view the ReadMe file.

10. Click Finish.
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7 - Uninstalling the Software
You can uninstall all of the Ansys and third party software discussed within this guide using the
Windows Control Panel. Specifically, the following application are listed in the Programs and
Features applet and can be uninstalled from there:

l Ansys Electromagnetics Remote Simulation Manager (RSM)
l Ansys Electromagnetics Suite
l Ansys Layout Integrations for ECAD Translators
l Microsoft MPI
l Intel MPI

Use the following procedure to uninstall any of these applications:

1. From theWindows Start Menu, selectWindows System > Control Panel.

The Control Panel window appears.

2. The next instruction depends on the display mode of your Windows Control Panel:
l If the current "View by" selection is Category, then:

Under Programs, click Uninstall a program.

l If the current "View by" selection is either Large icons or Small icons, then:

Click Programs and Features.

In either case, the Programs and Features window appears.

3. Locate the application that you wish to uninstall and click to select it.
4. Just above the list of programs, click Uninstall.

Alternatively, you can right-click the program to remove and choose Uninstall from the
shortcut menu.

5. Follow the screen prompts to complete the uninstallation process.
6. Repeat steps 3 through 5 for each application you wish to uninstall.
7. When finished, close the Programs and Features and Control Panel windows.
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A - Silent Installation
The Ansys Electromagnetics Suite silent installation feature installs the software on your
computer with no windows appearing during the installation process. InstallShield suppresses all
dialog boxes, including error messages and informational message boxes.

There are two ways to perform silent installations:

l Method 1: Silent Installation from the Command Line
l Method 2: Silent Installation Using a Response File

Method 1: Silent Installation from the Command
Line
For this method, options for running the installation program (setup.exe) are included directly in
the command line.

The applicable options for this method are as follows:

l -help: Displays a list of valid arguments for a silent installation.
l -silent: Run a completely silent installation.

Do not confuse this option with the standard "-s" InstallShield option, which expects a
response file for providing the necessary installation parameters. This custom "-silent"
option does not look for a response file and expects all necessary parameters to be
specified within the command line.

l -install_dir: Specify the path to the installation directory when not using the default
location.

Syntax: -install_dir <installation_directory_path>

The default path,%ProgramFiles%\AnsysEM, is used if this option is omitted.

l -server_info: Specify the port number and name of the license server(s).

Single Server Syntax: -server_info <port_number:hostname>

Redundant Server Syntax: -server_info <port_
number:hostname1,hostname2,hostname3>

The default port and server, if not specified, is 1055:<local_machine_name>, unless an
existing license configuration is found. In that case, the server information is taken from
the existing license file.

l -temp_dir: Specify the path to the temporary files directory when not using the default
location.

Syntax: -temp_dir <temp_directory_path>
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The Temp directory is used during local and remote simulations for temporary workspace.
The default path,%temp%, is used if this option is omitted.

l -temp_permissions: Specifies if Temp folder access is granted to all users or only the
current user.

Syntax: -temp_permissions [TRUE|FALSE]

When TRUE (the default value), read/write access to the Temp directory is granted to
EVERYONE. When FALSE, read/write access is only granted to the current user.

l -commonlib_dir: Specify the path to the common libraries directory if you will be using
previously installed libraries.

Syntax: -commonlib_dir <common_libraries_directory_path>

The default action is to install local libraries. Specifying this option prevents their
installation.

l -prereqs: Install only prerequisite software.

Use this option by itself (all other command line options will be ignored). It limits the scope
of the installation to the prerequisites portion. As such, setup.exe will install only .Net
Framework and Visual C++ Redistributables (assuming the required versions are not
already present on the system). An example of when this option is useful is for setting up
remote computing nodes for High Performance Computing (HPC), where the full Ansys
Electromagnetics Suite is not required on the host machines.

Note:

l All paths that contain one or more spaces must be enclosed in double quotes
("..."). You can also enclose paths without spaces in double quotes, but they are
not required.

l Specify absolute paths for softare installation, temporary files, and common
libraries locations.

l Absolute paths are recommended for the path to the installation command itself
(setup.exe). This is an executable file that often exists in multiple locations, and
a different one than intended may be included in your Path environment variable,
leading to unpredictable results. However, if the current folder of the command
prompt is already at the Ansys installer location, you could simply enter
.\setup.exe followed by the required options. Appending ".\" is required to
ensure that you access the setup.exe file in the currently active folder and not
any other one. It is also required in Windows PowerShell and the Windows 11
Terminal window for the command to be found.
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Command Line Examples:
l Example 1:Override the default installation and temporary file locations. The installer is
located at E:\Installers\AnsysEM:

E:\Installers\AnsysEM\setup.exe -install_dir D:\AnsysEM -temp_
dir C:\Temp

l Example 2: Specify a shared common libraries location on the network. For this
example, it is assumed that the command prompt is at the installer location:

.\setup.exe -silent -commonlib_dir
"\\LibraryServer\AnsysEM\Common Libraries"

l Example 3: Install prerequisite software only. For this example, it is assumed that the
installer is located on a network folder:

\\Software_Installers\Ansys\Electronics_242_
winx64\AnsysEM\setup.exe -prereqs

Method 2: Silent Installation Using a Response File
For this method, you record a response file during an initial command line installation using the
graphical user interface (GUI mode), not silently. For subsequent installations, run the
installation silently, specifying the response file to use. Tthe response file ensures a duplicate
configuration for all subsequent installations that reference it.

The applicable options for response file installations are as follows:

l -r: Run the installation in record mode, generating a response file.

The response file is recorded from the initial GUI-mode installation. The path and filename
of the response file are specified using the following -f1 option. The resultant file is then
specified in the command line for subsequent silent installations.

l -f1: Used to specify an alternative path and filename for the response file (whether
generating the file or using it to control a silent installation).

Syntax: -f1<response_file_path\name>

If this parameter is not specified, the default filename is <installer_name>.iss (for
example, setup.iss) and its location is in the same folder where the installer (such as
setup.exe) is located.

l -f2: Used to specify an alternative path and filename for the installation log file.

Syntax: -f2<log_file_path\name>
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If this parameter is not specified, the default filename is <installer_name>.log (for
example, setup.log) and its location is in the same folder where the installer (such as
setup.exe) is located.

l -s: Run the installation in silent mode using a response file and suppressing all dialog
boxes, including error and informational messages.

The installer looks for <installer_name>.iss (for example, setup.iss) in the same folder
where it resides. Use the -f1 parameter to specify an alternative response file path and
filename.

Do not confuse the standard "-s" InstallShield option with the custom "-silent" option,
which does not look for a response file and expects all necessary parameters to be
specified within the command line.

l -a: Perform an administrative installation.

An administrative installation copies all files to the destination path but does not create
shortcuts, register COM servers, or create an uninstallation log.

Recording a Response File
1. Open the Windows command prompt.
2. Locate the installation folder containing setup.exe or a patch file.
3. Run one of the following commands:

For a Full/New EM Suite Installation:

<path_to_setup.exe> -r -f1<path_to_.iss_response_file>

Note:

l If there are spaces in a file path, enclose the full path\filename in double
quotation marks. For example:

"E:\Ansys Installers\<version>\AnsysEM\setup.exe" -r -
f1"E:\Response Files\AnsysEM\<version>\setup.iss"

l The -f1 parameter can be omitted if the response filename is setup.iss and its
location is the same folder as setup.exe.

For a Self-Extracting Patch:

<path_to_patch.exe> -a -r -f1<path_to_.iss_response_file>

4. Follow the installation prompts.

Once complete, the *.iss response file will contain information that can be used to install
the same product with the same configuration on other Windows machines.
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Using a Response File
To use the response file:

To install the software on other computers running Windows, perform the following steps on
each machine:

1. Open the Windows command prompt.
2. Locate the Installation directory containing setup.exe, or the directory containing a patch

file.
3. Run one of the following commands:

For a Full/New EM Suite Installation:

<path_to_setup.exe> -s -f1<path_to_.iss_response_file> -f2<path_
to_.log_file>

Note:

l If there are spaces in a file path, enclose the full path\filename in double
quotation marks. For example:

"E:\Ansys Installers\<version>\AnsysEM\setup.exe" -s -
f1"E:\Response Files\AnsysEM\<version>\setup.iss" -
f2"E:\Installation Logs\AnsysEM\<version>\setup.log"

l The -f1 and -f2 parameters can be omitted if the default response and log
filenames and locations are used. Specifically, the defalut filenames are
setup.iss and setup.log, respectively, and both file locations default to the
same folder where the installer (setup.exe) resides.

For a Self-Extracting Patch:

<path_to_patch.exe> -s -f1<path_to_.iss_response_file> -f2<path_
to_.log_file>

In silent mode, no confirmation windows of any kind are displayed. InstallShield
suppresses all dialog boxes, including error messages and informational message boxes.

4. Verify that the installation was successful using the .log files. Open the *.log file created
during Step 3, and examine the ResultCode value in the [ResponseResult] section. If
the value is zero, installation was successful.

If a failure occurs in silent mode, Setup aborts just as if you clicked the Abort button in a
wizard dialog box during a normal installation. In this case, an error is written to the *.log
file.
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Note:

The installation typically fails for one of the following reasons:

l An invalid path was specified.
l There were differences in the dialog box sequences between the recorded
response file and the current silent installation. For example, an additional
message appeared during the playback due to differences in the two computer
systems.

Silent Mode Result Codes

Result Code Description

0 Success

-1 General error

-2 Invalid mode

-3 Required data not found in the Setup.iss file

-4 Not enough memory available

-5 File does not exist

-6 Cannot write to the response file

-7 Unable to write to the log file

-8 Invalid path to the InstallShield Silent response file

-9 Not a valid list type (string or number)

-10 Data type is invalid

-11 Unknown error during setup

-12 Dialog boxes are out of order

-51 Cannot create the specified folder

-52 Cannot access the specified file or folder

-53 Invalid option selected
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Performing a Silent Uninstall
You can perform a silent uninstall of the Ansys Electromagnetics Suite by entering the following
at the Windows command prompt:

<path_to_setup.exe> -runfromtemp -z suppressconfirmation -removeonly

Note:

Make sure there is a space before each dash (-).
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B - License hostids
Software licenses for each module of Ansys Electromagnetics products you purchased are
contained in one or more license files provided by ANSYS. Each license file requires one or
more license hostids, which are physical devices that contain a unique identification. License
hostids are always required for the license server, and they may also be required for each
machine running Ansys software.

Each supported operating system supports certain hostids:

Operating System Permitted Hostids

Windows

l The ethernet address of a network interface card 
(MAC address).

l Flexera FLEXid USB port hardware key.
l Disk serial number.

Linux
l The ethernet address of a network interface card 
(MAC address).

l Flexera FLEXid USB port hardware key.

The following sections describe the process for obtaining valid Windows hostids.

Obtaining a Disk Serial Number
To obtain the disk serial number:

1. Launch the Windows command prompt.
2. Type the following:

vol <DriveLetter>

For example:

vol C:

3. Press Enter.

Ansys also offers a utility that captures the disk id:

https://www.ansys.com/it-solutions/licensing/capture-license-server-information

Obtaining an Ethernet Address
A network interface card is a physical device used to connect to a network (also known as an
ethernet card). Each network interface card includes a unique ID that can be used as a license
hostid.
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You can obtain an ethernet address to use as a valid license hostid. The method for doing so
differs depending on whether you are running Windows or Red Hat Enterprise Linux.

To obtain an ethernet address as a valid license hostid when running Microsoft Windows:

1. If you are using a docked laptop, disconnect it from the docking station.
2. From theWindows command prompt, type the following:

ipconfig /all

3. Press Enter.

A list of network interface cards appears.

4. Look for the Physical Address line.

The ethernet address for the device is the value of the Physical Address, without
dashes.

Note:

Other types of adapters, including Point-to-Point Tunneling Protocol (PPTP)
adapters and the Microsoft Loopback Adapter, may be listed here. These are not
valid for license hostids.

Using a Hardware Key
A Flexera FLEXid hardware key may be provided to you by Ansys. The license hostid of a
hardware key is affixed to the hardware key itself. The hostid is a 17- to 21-character value that
begins with FLEXID=. Only a single device can be installed on each USB port.

To install a hardware key using a USB port:

1. Attach the hardware key to the USB port.
2. If a prompt appears asking you to install or specify a driver, click Cancel.

Consult Ansys License Manager documentation for instructions on using USB dongles:

https://www.ansys.com/it-solutions/licensing
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C - Enabling System Coupling with Maxwell
To enable coupling with Maxwell, the environment variable ANSYSEM_ROOT242must be set
to the location of your Ansys Electromagnetics installation.

Note: The environment variable name is ANSYSEM_ROOT<major><minor>, where
<major> is the two digit major version number (the last two digits of the year); and
<minor> is the one digit minor version number. For example, for the Ansys Electronics
2024 R2 release, the environment variable name is ANSYSEM_ROOT242. For the
Student Version of the software, the variable name is ANSYSEM_
ROOTSV<major><minor>.

l For Windows, this environment variable is automatically set during the installation of the
Ansys Electromagnetics Suite (for example, C:\Program Files\AnsysEM\v242\Win64).

Note: The environment variable must be set on all hosts if the analysis is distributed to
multiple hosts. For Windows, this environment variable must generally be set as a
System environment variable (not a user environment variable) for distributed analysis
so that it is set for the Ansoft RSM Service.
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